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OCO Trader Overview

OCO Trader is an X_TRADER® Pro Add-On application that submits and manages One-Cancels-Other (OCO) orders.  OCO Trader reacts to an order that was filled in the market that was submitted outside of the application, by submitting two orders, one at a specified number of ticks better than the fill price, and a second Stop Order at a specified number of ticks worse than the last fill price.  The Stop Order can be either submitted immediately or when a pre-described market quantity in the depth exists.  Various styles of stop orders can be submitted, such as trailing stops, stop limit orders, stop market orders, and virtual stops.

The user interface enables the trader to react to filled orders by sending a covering limit order, a limit order and a stop order, or just a stop order.  This flexibility gives the trader a powerful tool for their specific trading style and needs.  OCO Trader allows traders to set up a trading style or strategy on a per contract basis, by dragging and dropping the contracts to monitor.  The interface enables the trader to specify the customer for which the OCO order is being submitted on a contract basis.  Figure 1 below illustrates the OCO Trader with 11 contracts.  A maximum of 10 contracts are displayed without scrolling.

Installation

1. Verify that both X_TRADER and the X_TRADER API are installed.  Verify that X_TRADER Pro is enabled.

2. Double-click on the installation file (i.e. OCO_Trader_Install.exe).  This opens the OCO Trader installation wizard.

3. Click the Next button through all of the screens of the installation wizard, changing the default User Information and Destination Folder if desired. 

4. The application will be installed.  The last screen will display a message that OCO Trader was successfully installed. 

5. Click the Finish button.  An OCO Trader shortcut icon will be added to the Desktop.  The computer does not need to be rebooted

Product Features

OCO Trader Basics

6. When the application launches, it initializes itself with X_TRADER by downloading all of the fills and a label appears in the center of the application that states “Drag & Drop an Instrument from X_Trader”. The last active workspace will be restored.  If there was not an existing workspace to restore, the application will not take any action until contracts are dropped into the application from X_TRADER’s Market Explorer window.  The OCO Trader application supports any Exchange traded contract.

7. A contract is the combination of a Gateway, a Product, and the Expiration of the Future contract.  Ex. CME-A ES Sep06.

8. Numerous different contracts can be dropped from X_TRADER’s Market Explorer window to the OCO Trader application.  Newly dropped contracts will be added as a row item to the end of the list, duplicate contracts will be ignored. 

9. If a contract is dropped from X_TRADER's market grid to the OCO Trader application, all current positions will be ignored.  Once the contract is turned “On”, the rules associated with this contract will be applied. 

10. Closing the OCO Trader application will delete any resting orders submitted by OCO Trader.  Clearing a workspace by selecting File -> Clear will also delete any resting OCO Trader orders.  
OCO Trader – Menu Options

11. Within the File menu there are the following menu items: 

	· New
	Opens a new, empty OCO Trader workspace.

	· Open
	Opens an existing OCO Trader workspace.

	· Save
	Saves the workspace.  The default name is OCO Trader.ows.

	· Save As…
	Opens the Save As window to specify the name and location to save the workspace.

	· Clear
	Removes all rows from the Main Window and deletes all OCO Limit and Stop Orders that were entered into the market by OCO Trader.

	· <Workspaces>
	A list of up to the last five workspaces.  Selecting one will open the workspace.

	· Exit
	Deletes all OCO Limit and Stop orders that were entered into the market by OCO Trader and exits the OCO Trader application.


12. Within the Preferences menu there are the following menu items: 

	· View Stops
	Opens the Stop Detail window which displays all stops.  The stops displayed include both virtual stops and stops that are currently working in the market.

	· Delete Virtual Stops
	If selected the user will be prompted to confirm this selection to delete virtual stops.  If Yes is selected, all virtual stops will be deleted. 

	· Multiple Levels
	Opens the Multiple Level setup window for adding, removing and modifying the multiple level templates.

	· React to Own Orders
	Profit Orders – If selected, OCO Trader will react to a fill that was received on a Limit Order placed by OCO Trader.

	· 
	Stop Orders - If selected, OCO Trader will react to a fill that was received on a Stop Order placed by OCO Trader.

	· 
	NOTE:  In a fast market, having one or both of these preferences checked, could result in a large number of fills. These fills could occur at multiple levels and on both sides of the market.

	· Order Handling Mode
	Inside Market Mode – If selected, OCO Trader will react to the inside market for triggering stops and updating trailing stops.
Last Traded Price – If selected, OCO Trader will react to the Last Traded Price.

	· Confirm Activate/Deactivate All
	When selected, a confirmation message will pop up after the Activate All or Deactivate All buttons are pressed.

	· Default Settings
	Opens the Default Settings setup window to specify default values for new contracts added to OCO Trader.

	· Color Settings
	Opens the Select Colors window which enables users to customize the look and feel of OCO Trader.


13.  Within the Help menu there are the following menu items:

	· Contents
	Displays the OCO Trader ReadMe Document.

	· About OCO Trader
	OCO Trader version information.


14. Within the menu there are the following buttons:

	· Activate All
	Activates all of the rows within the main window.

	· Deactivate All
	Deactivates all of the rows within the main window.

	
	


OCO Trader – Main Window

[image: image3.png]LS 0CO Trader - 0CO Trader.ows

Fle preferences Help ¥ activate Al Q) Deactivate Al

Actve| Cortrsct Customer Carcel _Thieshold Stop Tral Offset Stoplimt Ofset _ Thieshold | Muliple Levels
| ceors:ze Mat7 JiDefos ¢ [ ][00 T 5 [~ =
CBOT-S: Z8 Jun07 ooz @ [ [iLever
CBOT-5: 28 Sepl? ) [
CBOTS: Z8 Decl? oo a [ [sLevets
CMES: E5 Mard? ot @ [~ Iiom
OME-5:ES Jund? [ @ [ =If
CME-S: ES Sepd7 [ioetas " g [ <[ [2Levess
OME-5:ES Decl? [ @ [ =If
CME S NG Jur7 [oo @ [
| CME-5: NO Secl? [E— 1] [

FilCount: 222 | The file "OCD Trader.os' has been saved.

<
<
LS

<
<
0
k|

<l
<
<
<
L]

0
<
<
0

k|

<l
<l

0
0
k|

<
<
<
<
LI

0
<
<
0

k|

<
L0 2
<

m
<
<

L]
<

L]

<
Bkl Ll fleb b b L L
<l

<
<
ik
<
ik




Figure 1 – OCO Trader Main window.
15. The OCO Trader window will resize to display up to 10 different contracts, after that a scroll bar will appear and will list all contracts that the user will be allowed to access using the OCO Trader application.

16. OCO Trader is launched every day by the user, when the user double-clicks on the desktop icon after they start X_TRADER® Pro.

17. The user can run numerous instances of OCO Trader on the user’s computer, but for convenience sake, the application will allow access to unlimited contracts.  Note: Caution should be taken not to duplicate contracts on multiple instances of the application.  This will cause each instance to submit an OCO order and thus multiply the number of OCO orders based on a single fill from within X_TRADER® Pro. 

18. If an order in X_TRADER® Pro is partially filled, the OCO Trader application will create a new order for the partially filled quantity.  If another fill occurs, then another separate opposite order is submitted for the partially filled amount at the filled price altered by the Offset value.  A fill received from a buy order will generate a sell order.  Similarly, a sell fill will take the filled price and create a Buy order.
19. OCO Trader provides a customer setup window that enables the user to select which customer profile will be submitting the order, which account(s) to filter or ignore, and whether to filter by an FFT2 or FFT3 value when a fill is received, see Figure 2 below.    Note:  The orders submitted via OCO Trader will have the X_TRADER Customer Defaults that correspond to the selected customer in this window.  For example, if OCO1’s D/C was GTC and Acct was G2, even though the fill was received for a GTD order that had an Acct of A1, the reactionary orders will be submitted as GTC, G2 orders.
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Figure 2 – Customer Setup window.
20. Within each contract (row), there are three main choices displayed as checkboxes.  Each one of the choices is mutually exclusive of the others:

· Cancel Entry Orders if market quantity does not satisfy the cancel operand and threshold.

· Enter a Covered Limit Order on all fills generated from non-OCO Trader submitted orders (i.e. orders placed in X_TRADER) or OCO Trader orders when using React To Own Orders.
· Enter a Stop Order on all fills generated from non-OCO Trader submitted orders (i.e. orders placed in X_TRADER) or OCO Trader orders when using React To Own Orders .
1. There will be a master switch per contract to turn the functionality “On” (Checkbox checked) or “Off” (Checkbox unchecked).  “On” denotes that when a fill from an external source is tracked by the OCO Trader application, then it will perform the rules that are defined for this contract.  “Off” denotes that no action will be performed for this contract.  Turning the contract’s status to “Off” for a contract will not delete any resting orders, but will terminate (i.e., not allow any more to be entered) the sending of orders for that contract from the OCO Trader Application.

2. OCO Trader orders that are filled will not send in another order, only ones entered from within X_TRADER® Pro.  If the user would like to react to orders that were sent by OCO Trader, they can select the “React To Own Orders” off of the “Preferences” menu item.  Selecting either “Profit Orders” or “Stop Orders” will enable OCO Trader to react to fill callback from the profit side or the Stop side of the OCO, respectively.
3. When the “Cancel” checkbox is checked, the Cancel operand and threshold input field will be visible.  When selected, the application will delete all non-OCO Trader orders resting at a price level where the total bid/offer size do not satisfy the threshold.  For example, let’s say you have a resting ES Mar07 limit buy order at 114475 which was entered outside of OCO Trader (i.e. through X_TRADER® Pro).  You can check the “Cancel” checkbox and indicate a threshold of “< 50”.  As a result, OCO Trader would automatically delete the resting 114475 buy order as soon as the total bid size falls below 50 contracts.

4. When the “Limit” checkbox is checked, the application will display and enable a spin control next to the “Limit” checkbox, which will allow the user to choose a value for each applicable contract.  The spin control value defines how many ticks better than the fill price the OCO Trader application should place a Limit Order when a fill is received (“Limit Offset”).  The value of the spin control will display by default the value that is displayed in the “Default Settings Window”.

5. When the “Stop” checkbox is checked, the OCO Trader application will show four components next to the “Stop” checkbox: 1) the Trailing Stop checkbox, 2) the stop offset spinner, 3) a “Stop LimitMarket” checkbox and limit offset spinner (only visible if the “Stop Limit” checkbox is checked), and 4) a Stop threshold value.  When the “Stop” is not checked these four components will disappear.  

· The trailing stop checkbox, when selected, will adjust the stop orders (visible or virtual) to trail the last price by the stop offset.

· The stop offset spinner sets how many ticks worse than the fill price the OCO Trader application should place a Stop Order when a fill is received.

· If the Stop Limit checkbox is selected, the stop limit offset spinner sets how many ticks worse than the fill price a stop limit order will be submitted when a fill is received.  The stop price is the fill price minus the stop offset and the stop limit is the fill price minus the sum of the stop offset plus the stop limit offset, where both offsets are valued in ticks.   If the Stop Limit checkbox is not selected, a Stop Market order is submitted.  

· The Stop Threshold value enables the user to submit either visible or virtual stop orders.  Virtual stop orders will be submitted as limit orders when the last traded price equals the stop price and the quantity in the depth satisfies the threshold operand.

6. When Limit and/or Stop are selected, the Multiple Levels checkbox is displayed.  The Multiple Level template can be selected from the drop-down list and the Multiple Level popup window can be viewed by clicking the “…” button.  Figure 3 shows the Multiple Level popup window.  Changing the name will create a duplicate Multiple Level template with the new name.  Rows can be added or removed and each value: Limit Offset, Stop Offset and Pct can be modified.  The total percentage (Pct) column must equate to 100% to commit the changes.  Refer to item 32 in the Workspaces and Preferences section for an explanation of how Multiple Levels work.  
Note: If the same template is used for more than one contract, any changes to the template will be applied globally to all of the contracts using the template.  
7. Users can delete individual rows from the OCO Trader form by right clicking on the contract they wish to delete and selecting “Remove Row.” Removing a row will delete all OCO Orders that have been placed for that contract.
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Figure 3 – Multiple Level Popup window.
8. Users trading products on the SFE exchange will see an MLM column displayed, as in Figure 4. When this box is checked, OCO Trader will submit MLM orders in place of any limit order.
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Figure 4 – OCO Trader Main window showing MLM Column.
Workspaces and Preferences

9. OCO Trader supports the saving and loading of workspaces.  The workspace that is active when OCO Trader is closed will be restored when the application is launched again.
10. The default values for newly added contracts will be the same default values that previously had been set by the user in the default window.  The “Default Settings Window”, off of the Preferences menu item, allows the user to modify the default settings for newly dropped contracts, see Figure 5 below.
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   Figure 5 – Default Settings window.
11. The Select Colors form, Figure 6 below, enables the user to customize the look and feel of the OCO Trader.  Clicking on any of the colored squares enables the user to change the color of the selected item.  Clicking “Update”, updates the OCO Trader form and clicking the “Restore Defaults”, restores the original color schema. 
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Figure 6 – Select Color window.
12. From the Preference menu, the user can view all stops, either virtual or in the market and are currently working in the system, see Figure 7 below.  The column headers can be drag-n-dropped to the top section to organize the stops per the user specifications, see Figure 8 below.

13. By right clicking on a row in the Stop Detail window, users can delete stored stops.
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Figure 7 – Stop Detail window.
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Figure 8 – Stop Detail window.
14. The Multiple Levels setup window is used to configure the Multiple Level templates.  See Figure 9 below.  These templates can then be applied to individual contracts within OCO Trader’s main window using the Multiple Levels checkbox.  Multiple Levels places a percentage of each offsetting limit and/or stop orders at the specified tick offset.  The order of execution starts with the level with the highest percent allocated to it and sequentially distributes based on which level is furthest from fulfilling its allocation percent. Any ties go to the lower level number.  See the examples in Appendix A for a screenshot and examples of different scenarios. 
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Figure 9 – Multiple Level Setup window.
OCO Trader Order Types

	OCO Trader Order Types

	Limit Order
	If the Limit Checkbox is checked and a non-OCO Trader submitted fill is received or an OCO Trader submitted fill is received when using React To Own Orders, the application will place an opposite limit (e.g. Buy fill will create a Sell Order) order at the tick amount (0 through n) better than the fill price.  Ex. A fill comes in for a buy of 5 ES Sep03 at 11300 and the spin control is set to “2”, then the OCO Trader application will automatically submit a sell order of 5 ES Sep03 at 11350 which is 2 ticks above the fill that arrived.  This type of order is referred to as a Covered Limit Order.

	Stop Order
	If the Stop Checkbox is checked and a non-OCO Trader submitted fill is received or an OCO Trader submitted fill is received when using React To Own Orders, the application will place an opposite stop limit, stop market, or virtual stop order at the fill price minus the stop tick offset value.

· Stop Limit Order - When the “Threshold” value is zero or “-“ and the “Stop Limit” checkbox is selected a standard Stop Limit order will be submitted. A standard stop limit order will be submitted with a stop price equal to the fill price minus the stop tick offset and a stop limit price equal to the fill price minus the sum of the stop tick offset and the stop limit tick offset.  

· Stop Market Order - When the “Threshold” value is zero or “-“ and the “Stop Limit” checkbox is NOT selected a standard Stop Market order will be submitted. A standard stop market order will be submitted with a stop price equal to the fill price minus the stop tick offset.  

· Virtual Stop Order - A virtual stop order is an order that is stored and not visible in the order book until the threshold criteria has been met and either the contract has traded at the stop price if LTP Mode is selected as the Order Handling mode or the inside market has reached the stop price if Inside Market Mode is selected.  Once these conditions have been met, the order is submitted as a standard limit or market order, or an MLM order if the MLM checkbox is selected for a SFE contract.  Setting a threshold value greater than 0 will enable OCO Trader to submit a virtual stop.  Once a Stop Order is added to the market it will stay there until it is either filled or cancelled regardless if the market quantity at the stop price changes to a value that violates the threshold criteria.  If the only market quantity at the stop price is this Stop Order, and the threshold is enabled, the Stop Order will not be added to the market.  If the threshold has not been passed and the price moves forward (i.e., more of a loss), then the Stop Order will be submitted into the market with the rules that were defined for the contract (e.g., Market Order, Limit Order, or MLM Order).

· Trailing Stops - All Stop orders, submitted or virtual, can be trailing stops with the “Trail” Checkbox checked.  Selecting the checkbox at any time will enable trailing stops and deselecting will disable trailing stops.

	OCO Order
	An OCO-Order is a combination of a Profit Limit order and a Stop Loss order, where these two orders are tied together.  When one order is partially or completely filled, the other order is changed to the new value or deleted, respectively.  OCO Orders are submitted when both the Limit and Stop checkboxes are selected.  The application manages these two orders as if they were one order.  The stop side of the OCO Order will be trailing if the “Trail” checkbox is selected.

	Multiple Level OCO Order
	A Multiple Level OCO Order places an OCO Order with a percentage of the total order quantity at the offsets specified in the Multiple Level Setup window.


Version Comparison

OCO Trader has the following features that are not available in OCO Trader Ltd.:
· Cancel Thresholds - the application will delete all non-OCO Trader orders resting at a price level where the total bid/offer size do not satisfy the threshold.
· Stop Thresholds - enables the user to submit virtual stop orders.  Virtual stop orders will be submitted as limit orders when the last traded price equals the stop price and the quantity in the depth satisfies the threshold operand.
· Account Filtering – enables the user to choose which account(s) to ignore or react to when a fill is received.
Requirements

This application requires:

· X_TRADER® API 

· X_TRADER® Pro
Appendix A

Example 1 – Single Reactionary OCO with limit and stop orders.
This example shows how a sell order for a 10-lot was completely filled on CME-S ES Mar04 at 114525.  Once it was filled it immediately put in a buy stop market order for 10 at 114625, and a buy limit order for 10 at 114425.  If 1 of the buy limit order is filled, then it will reduce the size of the buy stop market order to 9. 
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Example 2 – Multiple Level Reactionary OCO with limit and stop orders.
The “3 Levels” template shown below contains three levels with 5, 6, and 7 limit and stop offsets.  1/3rd of the filled order (10-lot, filled at 114625) will have an OCO placed at 5 ticks, 1/3rd will be placed at 6 ticks and finally 1/3rd at 7 ticks.  Because 1/3rd does not equate to a whole number to fulfill 100 percent, a round-off of 1-lot is added to the third level because it has a higher percent allocated to it.
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Example 3 – Multiple Level Reactionary OCO with limit and stop orders.
As a continuation of Example 2, if the lot size was 11, instead of 10, there would be a tie between Level 1 and Level 2 for which gets the final lot allocated to it. OCO Trader will settle ties by allocating the order to the lowest level, which in this case is Level 1. It is important to note that if traders want additional lots allocated closest to the inside market, they should put their levels with the lowest offset at the top of the Multiple Level Setup window. 
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